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Styles Tool 
 

1. The Styles tool gives the ability to define a pre-set 

collection of font styles that make it easy and 

automatic to use branding throughout a document. 

2. The “Styles” tool is located on the Home ribbon in Microsoft Word. 

3. The default text in a document is usually the “Normal” style. Various Heading, Quote, and Emphasis 

styles also have defaults set (access these by click on the drop-down arrow circled in the Styles image). 

4. Assign a style to the text in a document by selecting the text, and clicking on the Style to apply. 

5. An alternate (possibly easier) method to edit a Style is to change the font in the document to the desired 

look, select the edited text and right-click on the style that is being edited in the Styles toolbar. Choose 

the first option in the window that appears… “Update [Heading 1] to Match Selection” the text as a 

“New Quick Style.  

6. Another alternate method to edit a Style is to right click on the style in the “Styles” toolbar and select 

“Modify” – this will provide full access to all editing possibilities.  

 

 

Bullets & Numbering 
 

1. Add bullets or numbering to a document by clicking on the bullet or 

numbering button in the “Paragraph” section of the Home ribbon. Word 

will automatically indent and begin numbering or bulleting as text is 

added.  

2. An alternate method is to select already typed text and click on the bullet or number buttons.  

3. Additional formatting is available by clicking on the drop-down next to the bullet or number buttons. 

Pre-formatted buttons/numbers are listed to select from or the “Define New Bullet/Number” option is 

also available. 
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Tabs 
 

1. Easily add tabs to a document by using the 

“Tab” button that displays in the upper left of 

the Ruler. If Ruler does not display, select the 

“View” tab and check the box next to “Ruler” in 

the “Show” section of the ribbon. 

2. Select the type of tab wanted (based on the 

direction the text will align) by clicking on the 

Tab button (circled in graphic) until the correct 

tab is showing. Once a tab is selected, click on the ruler to place a tab. 

3. Once the tab is placed, it can be moved by clicking and holding and dragging it to a different position on 

the ruler. 

4. Double-click on tab in the ruler in order to open the “Tabs” window which allows additional editing and 

formatting options. 

 
 

Paragraph Alignment & Spacing 
 

1. To adjust paragraph alignment and spacing, look to the “Paragraph” 

section on the Home ribbon.  

2. Easy-access buttons on the ribbon include “Decrease Indent,” “Increase 

Indent,” Indentation,” and “Line & Paragraph Spacing.” For 

additional paragraph formatting options, click on the submenu 

button in the corner of the paragraph ribbon. 

 
 

Tables 
 

1. Add “Tables” to a document through the “Insert” ribbon.  

2. Select the number of tables and rows needed, click on the last box in 

the grid selected, and a table will automatically insert into a 

document. 
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3. Once a table is inserted, a “Table Tools” ribbon will be available with several “Design” and “Layout” 

options for the table. 

4. Convert text to a table (or vice versa) by selecting the text to convert, clicking on the “Table” drop-down 

under the “Insert” ribbon and selecting “Convert Text to Table…” (or Convert Table to Text…). A window 

will open with options for best converting the text. 

 
 

Sectioning a Document 
So you can have different text in your headers/footers 
 
When a Word document is first created, it defaults to one section and the headers and footers used in the 

document will display on every page. When creating an RFI response, and trying to keep it all in one document, 

it can be helpful to have different headers or footers throughout. This is how to section a document: 

 

C H A N G I N G  J U S T  T H E  F I R S T  P A G E  F R O M  T H E  R E S T  O F  A  D O C U M E N T   

1. Word has set up a simple way to automatically section the 

first page from the rest of a document. This can be helpful 

if starting an RFI response with a cover letter and 

maintaining the same header/footer after the cover letter. 

If more than two header/footer changes might be required… use the “Section Breaks” method outlined 

below. 

2. Under the “Page Layout” ribbon, in the “Page Setup” section, click on the submenu button to open the 

“Page Setup” window. 

3. Under the “Layout” tab in the “Headers and Footers” section check the box that says “Different first 

page” and click OK. 

4. The first page will then always allow a different header/footer from the rest of the document. 

 

U S I N G  S E C T I O N  B R E A K S  T O  V A R Y  H E A D E R S  A N D  F O O T E R S  

1. This method works best when headers/footers might need 

to vary on more than two occurrences.  

2. Under the “Page Layout” ribbon, in the “Page Setup” 

section, click on the “Breaks” drop-down arrow. There are 
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two main kinds of breaks available; Page Breaks and Section Breaks.  

3. Click on “Next Page” under Section Breaks. A new page will be inserted into the document. 

4. Next, open the Header/Footer by double-clicking in the header or foot space. A “Header & Footer 

Design” section will be added to the ribbon and provide tools to continue setting up the document. 

5. With the Header/Footer open, notice the tab that accompanies each Header/Footer on every page. It 

will say “Header – Section 1-“ or 

Footer – Section 1-“ These 

section numbers will change as 

you add more sections to the 

document.  

6. With the “Header & Footer Design” ribbon open, in the “Navigation” 

section, there is a button that will be highlighted in yellow – “Link to 

Previous.” By default, headers and footers are linked to each other 

so their contents displays on all pages. In order to have different 

headers and footers, this link must be broken.  

7. To break the link, simply turn off the “Link to Previous” option by clicking on the button. If highlighted in 

yellow it is activated. If not highlighted, it is not linked. 

8. Once the link is broken, contents can be changed in your header or footer.  

9. This link exists independently in both the header and footer so the link will need to be broken in the 

header and again in the footer. The only reason to break the link in the footer is if you want to have 

differing page number styles. 

10. For every new section added to a document, the link to the previous section will have to be disabled. 

 
 

Saving as PDF from Word 
 

11. In Word document, with document open, select File  Save As. 

12. In Save As Window, below the “File Name” in the “Save as type” drop-down, select “PDF (*.pdf). 

 

13. Click the “Save” button in lower right corner. 
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Saving as PDF from www.freepdfconvert.com   
 

1. Under the “PDF Converter” tab, click on the “Select Files…” button. 

2. A “Choose File to Upload” window will open, navigate to the location of your file, select, and click 

“Open.” 

3. A banner will open across the webpage inviting you to sign up for membership (section will be 

highlighted in red) – ignore this. 

4. Below the “Sign Up” option click on the blue “Convert” button. 

5. Conversion will begin and take a few seconds (longer depending on file size). 

6. When conversion is finished a green “Download” button will appear. Click on that and save the file to 

your computer. 

 
 

Snipping Tool 
 

1. The Snipping Tool is a new feature in Windows 

that allows you to capture on image off of your 

screen. It is like the “Print Screen” button on your 

keyboard, but allows you to customize exactly 

what you are capturing. 

2. Open the Snipping Tool from your Start Menu  Accessories folder 

3. Click “New” and draw a box around the image to be captured. 

4. The image will display in the snipping tool window and options to save, copy, or email are available. 

5. A pen and highlighter are also available to draw or mark-up the image. 

 
 

Resizing Photos 
 
Sometimes you need a smaller copy of a photo for a project. Generally, for electronic documents, you want the 
size of the photo to be 50 kb or smaller. 
 
Note: Keep in mind that resizing is different from cropping. Resizing changes the dimensions or quality of an 
entire photo, while cropping makes a photo smaller by removing part of it. 
 
Due to the many different versions of Microsoft operating systems and software capabilities, we’ve provided a 
few different resizing options for you to try with your computer.  

http://www.freepdfconvert.com/
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 Resize photos in Windows Live Photo Gallery 

 Resize photos in Microsoft Office Picture Manager (Microsoft Office Suite 2007-2010) 

 Resize photos to send in email from Windows Photo Viewer 

 Resize photos using the Image Resizer tool (requires download and install) 

 Resize photos using the internet 

 Compress photos in Microsoft Word 

 
 

Resize photos in Windows Live Photo Gallery 
Windows 7 
http://windows.microsoft.com/en-US/windows-
vista/Resize-photos-in-Windows-Live-Photo-Gallery 
 

1. Select the photo you want to resize, and 

then, on the File menu, click Resize. 

2. In the Resize dialog box, select the size you 

want to make the photo. 

3. If you want to be able to print the photo, 

choose a larger size. If you're only going to view the photo on 

the screen, choose a size that looks good on your monitor. 

Experiment with different sizes to learn which will work best for 

your project. Keep in mind that Maximum dimensions is the 

number of pixels along the longest side of your photo. For 

example, in a 4 × 6 photo, if the 6-inch side is 1024 pixels, the 4-

inch side is 682. 

4. Click Resize and Save. 

5. Photo Gallery will save the resized file in the same location as 

the original, and will add the dimensions to the file name of the 

smaller copy. For example, if the original photo is named 

"Scooter" and is saved in your Pictures folder, the resized photo 

is named "Scooter (1024x682)" and is also in the Pictures folder. 

(If you want to change the file name or location, click Browse, 

change the name and location, and then click Resize and Save.) 

 

http://windows.microsoft.com/en-US/windows-vista/Resize-photos-in-Windows-Live-Photo-Gallery
http://windows.microsoft.com/en-US/windows-vista/Resize-photos-in-Windows-Live-Photo-Gallery
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Resize photos in Microsoft Office Picture Manager  
Microsoft Office 2007-2010 
 

1. Open photo in Microsoft Office Picture Manager. 

2. Click on Picture in the top Menu bar. 

3. Click Resize (the Resize window will open). 

4. Select a Predefined size for the image or use your own custom sizes. Click OK. 

5. Save your picture (original picture will be overwritten if you don’t Save As). 

6. Close out of Microsoft Office Picture Manager without saving changes to the original. 

 

Note: When you edit a photo in Picture Manager and Save As, it does not change the file name of the image 
open in the manager. It saves a copy of the image and keeps the original, edited version, open in the manager. If 
you close out of the Picture Manager and save your changes when prompted, it overwrites the original image. 
 
Because of this, you may want to back up your original photos just in case you accidentally overwrite them with 
the smaller file size.  

 
 

Resize photos to send in email from Windows Photo 

Viewer 
Windows Vista – Windows 8 
 

1. Open Windows Explorer. 

2. Navigate to the Photo you want to send and double click on photo (photo should open in Windows 

Photo Viewer). 

3. Click E-mail in the top toolbar. 

4. A window will open with a drop down list for Picture Size. 

5. Select the size you want to use (it will show you the estimated file size below the drop down after 

you’ve selected the size you want). 

6. Click Attach once you have the desired size selected. 

7. If you use Microsoft Outlook or another Microsoft email program it will open the program and create a 

new email with the photo attached. 
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8. From here you can right click on the attached photo and select Save As to save it to your computer (it’s 

possible you may have to email the photo to 

yourself before you can do this step). 

 
 

Resize photos using the 

Image Resizer tool  

Windows Vista – Windows 8 (requires download and 
install) 
 
 
http://imageresizer.codeplex.com  
 
Image Resizer for Windows is a utility that lets you 
resize one or more selected image files directly from 
Windows Explorer by right-clicking. 
 

1. Download the installer (visit link above and install). 

2. Open Windows Explorer (different from Internet Explorer). 

3. Navigate to the photo you want to resize and “Right-Click.” 

4. Choose settings from “Image Resizer for Windows” window that opens and click “Resize.” 

 
 

Resize photos using the internet 
All Computers 
 

1. http://www.shrinkpictures.com/ 

2. Scroll down to Resize Images dialogue box. 

3. Choose the Picture you want to resize by clicking Browse and navigating to the image on your computer. 

4. Select the new dimensions you want to use (350 pixels recommended or use the Custom box to make a 

little larger/smaller). 

5. Click on Resize (a new page will load with a link for you to click on to download the new image). 

6. Click on Download this picture now and save it to your computer. 

 
 

  

http://imageresizer.codeplex.com/
http://www.shrinkpictures.com/
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Compress photos in Microsoft Word 
 
Another option is available for reducing photo sizes and it only requires Microsoft Word. Use 
this option when creating your submission in Word and including pictures in the 
document. When you use the following method, it only changes the size of the photos in the 

document and these adjustments won’t be reflected in the 
original photo.  
 

1. Insert your photos into your Word document 

2. Click on any image in your document and the 

“Picture Tools Format” tab will appear. Click on the 

tab to open the toolbar 

3. On the “Picture Tools Format” toolbar, with your 

photo still selected, click on the “Compress 

Pictures” button in the “Adjust” section (should be 

on the left of toolbar) 

4. From the Compress Pictures window, you can 

choose to:  

- work with just your selected picture or all the pictures in the document 

- delete cropped areas of the picture if you have done some cropping 

- change the resolution (Screen or Email setting recommended) 

5. Choose the settings you want and hit OK 

6. Save your changes and your document size should adjust accordingly. View under File  Properties  

Size 
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Join.Me 
Join.me is a free, easy to use online tool that allows users to invite others to view their computer screen. If 

you’re having problems with formatting, you can set up a phone call and join.me session with Amy or Jenny and 

we can walk you through any difficulties you might be having. To use Join.Me: 

1. Go Here: https://join.me/  

2. Click on the Start Meeting box 

3. If a window comes up asking if you should Run the program, click 

“Run” 

4. The website will then connect to your screen and 

bring up this little tool at the top of your webpage: 

Click on the URL-looking link… join.me/341-228-987 

5. A balloon will pop out giving you the option of 

copying or emailing this link  

6. Select the email option and an email will automatically populate from your Outlook with the link and 

necessary login information (if the email doesn’t automatically populate, select the Copy option and 

you’ll have to go to your email software and create your own email and paste the link in there). 

7. Send to people you want to invite. 

8. They will then just have to click on the link in the email and they should be able to view your screen. 

9. Once they are connected, chat capabilities are activated… or you could just use your desk phone and call 

(probably easier). 

10. You can also turn over control of your screen to those viewing and let them make a change to your 

document or move the pointer to what they might be talking about. 

 

 

 

 

 

711 E Well Ave 
Pierre, SD 57501-3369 

800-872-6190 | F: 605-773-3256 
goedinfo@state.sd.us  

www.SDreadytowork.com  

https://join.me/
mailto:goedinfo@state.sd.us
http://www.sdreadytowork.com/

